First Printing, January 1987

© Digital Equipment Corporation 1987. All Rights Reserved.

The information in this document is subject to change without notice and should not be construed as a commitment by Digital Equipment Corporation. Digital Equipment Corporation assumes no responsibility for any errors that may appear in this document.

The software described in this document is furnished under a license and may only be used or copied in accordance with the terms of such license.

No responsibility is assumed for the use or reliability of software on equipment that is not supplied by DIGITAL or its affiliated companies.

Several Program Information Files and device drivers are supplied for use with non-DIGITAL products and referenced in this document. These are provided on an “AS IS” basis without any warranty of any kind, either expressed or implied.

FCC Notice: This equipment generates, uses, and may emit radio frequency energy. The equipment has been type tested and found to comply with the limits for a Class A computing device pursuant to Subpart J of Part 15 of FCC Rules, which are designed to provide reasonable protection against such a commercial environment. Operation of this equipment in a residential area may cause interference in which case, the user, at his own expense, may be required to take measures to correct the interference.

MS-DOS and Multiplan are trademarks of Microsoft Corporation.
dBASE is a trademark of Ashton-Tate, Inc.
IBM is a registered trademark of International Business Machines, Inc.

The following are trademarks of Digital Equipment Corporation:

```
DIGITAL  MASSBUS  VAX
DEC      PDP     VAXmate
DECmate  P/OS    VMS
DECsystem-10  Professional  VT
DECSYSTEM-20  Rainbow  VT220 Terminal Emulator
DECUS     RSTS    VT240 Terminal Emulator
DECwriter RSX     Work Processor
DIBOL     UNIBUS
```

The postage-paid READER’S COMMENTS form at the back of this document requests the user’s critical evaluation to assist us in preparing future documentation.

Printed in U.S.A.
To the VAXmate User’s Guide reader,

These pages contain corrections to pages in your VAXmate User's Guide, Volume 1. To update your guide with these pages, use the following table. The table lists the old pages you should remove and the new replacement pages you should insert in your guide.

<table>
<thead>
<tr>
<th>PAGES TO REMOVE</th>
<th>PAGES TO INSERT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1</td>
<td></td>
</tr>
<tr>
<td>1-1, 1-2</td>
<td>1-1, 1-2</td>
</tr>
<tr>
<td>1-9 through 1-12</td>
<td>1-9 through 1-12</td>
</tr>
<tr>
<td>Chapter 3</td>
<td></td>
</tr>
<tr>
<td>3-13, through 3-16</td>
<td>3-13 through 3-16</td>
</tr>
<tr>
<td>Chapter 4</td>
<td></td>
</tr>
<tr>
<td>4-7, 4-8</td>
<td>4-7, 4-8</td>
</tr>
<tr>
<td>Chapter 5</td>
<td></td>
</tr>
<tr>
<td>5-5, 5-6</td>
<td>5-5, 5-6</td>
</tr>
<tr>
<td>5-9, 5-10</td>
<td>5-9, 5-10</td>
</tr>
<tr>
<td>Chapter 6</td>
<td></td>
</tr>
<tr>
<td>6-17, 6-18</td>
<td>6-17, 6-18</td>
</tr>
<tr>
<td>Chapter 7</td>
<td></td>
</tr>
<tr>
<td>7-1, 7-2</td>
<td>7-1, 7-2, 7-2.1</td>
</tr>
<tr>
<td>7-9 through 7-11</td>
<td>7-9 through 7-11</td>
</tr>
<tr>
<td>PAGES TO REMOVE</td>
<td>PAGES TO INSERT</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Chapter 8</td>
<td>Chapter 10</td>
</tr>
<tr>
<td>8-7 through 8-22</td>
<td>8-7 through 8-22</td>
</tr>
<tr>
<td>Chapter 10</td>
<td>Chapter 12</td>
</tr>
<tr>
<td>10-3, 10-4</td>
<td>10-3, 10-4</td>
</tr>
<tr>
<td>Chapter 12</td>
<td>Chapter 20</td>
</tr>
<tr>
<td>12-13, 12-14</td>
<td>12-13, 12-14</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Appendix A</td>
</tr>
<tr>
<td>20-17, 20-18</td>
<td>A-7 through A-10</td>
</tr>
<tr>
<td>Appendix A</td>
<td>Appendix B</td>
</tr>
<tr>
<td>A-7 through A-10</td>
<td>B-5 through B-10</td>
</tr>
<tr>
<td>Appendix B</td>
<td>B-15, B-16</td>
</tr>
<tr>
<td>B-5 through B-10</td>
<td>B-25 though B-27</td>
</tr>
<tr>
<td>B-15, B-16</td>
<td>B-15, B-16</td>
</tr>
<tr>
<td>B-25 though B-27</td>
<td>B-25 though B-27</td>
</tr>
<tr>
<td>Appendix C</td>
<td></td>
</tr>
<tr>
<td>C-1 through C-15</td>
<td>C-1 through C-15</td>
</tr>
</tbody>
</table>
Chapter 1
Getting Started
With MS-Windows

MS-Windows lets you work visually by organizing your tasks in windows. With MS-Windows, you can have more than one window on your screen, each running a different application. Thus, you can simultaneously work on several tasks, such as writing a memo, updating a project status report, and organizing data for a monthly report.

With MS-Windows, you switch from one application to another by clicking the mouse button or pressing keys. Because you never have to stop running an application, you can continue in any application where you left off.

With MS-Windows, you do not have to memorize formats or type many commands. Each application has all the necessary commands contained in a series of menus; you select a command from a menu.

MS-Windows lets you transfer information between your MS-Windows applications. For example, you can copy information from a project status report to a monthly report while running both in the work area of your screen.

This chapter describes how to:

• Start MS-Windows
• Work in MS-Windows
• Run an application
• Use the Information System
• Scroll a window
• Use menus and commands
• Use a dialog box
• Finish an application
GETTING STARTED WITH MS-Windows

Starting MS-Windows

Information on starting MS-Windows and other introductory MS-Windows material, including definitions for terms such as icon, work area, and mouse, is contained in your handbook. If you have not read the handbook, do so before continuing.

Initial Window

The first window you see when you start MS-Windows depends upon how MS-Windows is installed on your workstation. When MS-Windows is installed on your workstation, you can:

- Run a specific application automatically in the work area each time you start MS-Windows
- Load specific applications as icons
  This is desirable if you consistently use several applications.
- Open the MS-DOS Executive window

If you run and load applications when MS-Windows is installed, the first window you see is the application that is set up to run automatically. You also see the icons for the applications in the icon area at the bottom of the screen. For information about running and loading applications, see Chapter 3.

If you do not run or load applications when MS-Windows is installed, the first window you see is the MS-DOS Executive window. You can load applications into the icon area.

Working in MS-Windows

You work in MS-Windows by using the mouse or the keyboard to select and perform commands. You will probably use the mouse most often because you can enter most commands by pointing the mouse to the command and clicking the left mouse button. In general, this guide describes how to enter MS-Windows commands, using the mouse. For information on using the keyboard to enter commands, see Chapter 6.

If you unplug your mouse and plug it back in, the mouse will not work. To get your mouse to work again, exit and restart MS-Windows.
Screen 1-2  Dialog Box

A dialog box is a rectangle, resembling a window, which overlays a portion of the screen in which you select a command. If you display several windows in the work area, the dialog box can overlay portions of more than one window, depending on the size of the windows and the dialog box.

The dialog box contains areas where you either type the information required by MS-Windows or select options to supply the needed information.

Often, a dialog box is displayed with some information already in it, showing what you have selected on the screen or options you selected earlier. Also, some options may be disabled.

After you enter information or select an option, you execute the action by selecting a command button in the dialog box.
The following sections describe the components of a dialog box.

**Text Box**

A text box is where you type information needed to carry out a command. Figure 1-2 shows a text box.

![File name:](image)

**Figure 1-2  Text Box**

What you type is displayed to the left of the blinking vertical line, called the insertion point. To position the insertion point in the text box, click where you want the insertion point moved. As you type, the insertion point moves to the right.

To correct typing mistakes, press the Word Char key. Each time you press it, one character to the left of the insertion point is deleted.

The text box can:

- Be blank when the dialog box is displayed
- Contain text if you already selected something applicable for the command
- Contain a default option

If information is already present in the text box, you can type new information. When you press the first key, any information already present is removed. You can also press the Word Char key to delete information already in the text box.

**List Box**

A list box lists the choices you can select for a command. Figure 1-3 shows a list box.
You can distinguish between files, drives, and directories listed in a dialog box. For example, in the list box shown in Figure 1-3:

- **MYFILE** is the name of the file, MYFILE.
- [-A-] represents drive A. Brackets and hyphens surround the name of a drive.
- [...] represents the parent directory (one level up).
- [MYDIR] represents directory MYDIR. Brackets surround the name of a directory.

To select an item in the list box, click on it.

**Option Buttons**

Option buttons let you select one option from a group. They are labeled to describe their functions. Figure 1-4 shows the option buttons for controlling the keyclick volume.

![Keyclick volume](image)

To select an option from a group, click on it.
Check Boxes

Check boxes represent options that you can turn ON or OFF. They are labeled to describe the functions of the options. When an X is displayed in the check box, the option is ON. Click on X again to turn the option OFF. You can select as many check boxes as needed. Figure 1-5 shows a check box for a mouse option.

Mouse Options

☐ Left/right mouse buttons swapped

Figure 1-5 Check Box

To select a check box, click on it.

Command Buttons

Command buttons are large rectangular buttons (with rounded corners) that are labeled to describe how they affect the command you selected. Figure 1-6 shows sample command buttons.

Ok Cancel

Figure 1-6 Command Buttons

To select a command button, click on it.
Using the File Name

To run an application in your default directory, double-click on the file name of the application you want to run.

The file name is highlighted.

The cursor temporarily changes to an hourglass, indicating that MS-Windows is loading the application into memory.

The application you selected replaces the MS-DOS Executive application in the window. The MS-DOS Executive application changes to an icon.

Using Temporary Files

Some applications that run with MS-Windows create temporary files with the file extension .TMP to store your work.

The file names for temporary files begin with a tilde character and letters indicating the application name. For example, a temporary file for MS-Paint has the file name ~MSP.TMP.

You can create a special directory on your local hard disk drive to hold temporary files. To send temporary files to a directory, put the SET TEMP command in your AUTOEXEC.BAT file.

Do not delete these files while MS-Windows is running, because an application may be using them. You can delete them after quitting your MS-Windows session.

Running Batch Files

You run batch files only from the MS-DOS Executive window. If you run a standard application from a batch file, you should create a PIF for the batch file. For more information about PIFs, see Appendix C.

Set options in the batch file's PIF to be the same as the application’s PIF. However, set the Memory Required and Memory Desired options for the batch file’s PIF to 32K, regardless of the memory requirements for the application.
Using MS-DOS Commands and Programs

MS-DOS commands are divided into three groups:

- Commands you cannot use from MS-Windows
- Commands you run from MS-Windows with COMMAND.COM
- Commands you run from the MS-DOS Executive window

Those commands that you cannot run from MS-Windows, you can run from the MS-DOS operating system prompt. Or, you can put these commands in your AUTOEXEC.BAT file, which runs automatically before MS-Windows starts. For more information on MS-DOS commands and programs, see Volume 2 of this guide.

The MS-DOS commands you should not run from MS-Windows are:

<table>
<thead>
<tr>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPEND</td>
</tr>
<tr>
<td>ASSIGN</td>
</tr>
<tr>
<td>CHKDSK</td>
</tr>
<tr>
<td>CTTY</td>
</tr>
<tr>
<td>FONT</td>
</tr>
</tbody>
</table>

The MS-DOS commands you can run in MS-Windows from the Command window are:

<table>
<thead>
<tr>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>BREAK</td>
</tr>
<tr>
<td>CHDIR *</td>
</tr>
<tr>
<td>CLS</td>
</tr>
<tr>
<td>COPY *</td>
</tr>
<tr>
<td>DATE *</td>
</tr>
<tr>
<td>DEL *</td>
</tr>
<tr>
<td>DIR *</td>
</tr>
</tbody>
</table>

The MS-DOS commands you can run from the MS-DOS Executive window are:

<table>
<thead>
<tr>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATTRIB</td>
</tr>
<tr>
<td>BACKUP</td>
</tr>
<tr>
<td>COMMAND</td>
</tr>
<tr>
<td>DEBUG</td>
</tr>
<tr>
<td>DISKCOPY</td>
</tr>
</tbody>
</table>

* These commands have an MS-Windows equivalent.

3-14
Running an MS-DOS Operating System Program

To run an MS-DOS command in MS-Windows with COMMAND.COM:

1. Select the RUN command from the File menu in the MS-DOS Executive window.
2. In the dialog box, type:
   COMMAND
3. Click on the OK command button.
   The MS-DOS command processor starts in a window titled "Command."
4. Type the MS-DOS command and command arguments you want at the MS-DOS prompt.
5. To stop using COMMAND.COM, type:
   EXIT
   The window title is now enclosed in parentheses.
6. Close the window.

To run an MS-DOS command from the MS-DOS Executive window:

1. Select the RUN command from the File menu.
2. Type the command name and its arguments in the dialog box.
3. Close the window.
   If the application does not stop automatically, type the Exit command and then close the window.

Finishing an MS-Windows Session

To finish an MS-Windows session:

1. Save all files you have worked on.
2. Exit from any standard application still running in a window or as an icon.
Using the MS-DOS Executive Window

3. From the MS-DOS Executive window, end your MS-Windows session by using one of the following methods:
   • Double-click on the System menu box.
   • Select the Close command from the System menu.
   • Select the End Session command from the Special menu.

   With any method, a dialog box is displayed, indicating that this action ends your MS-Windows session.

4. Click on the Ok command button.

   MS-Windows closes, and the MS-DOS operating system prompt is displayed on the screen.

   **NOTE**
   You can now enter MS-DOS commands. To restart MS-Windows from the MS-DOS operating system prompt, type:
   
   WIN

   Press the Return key. The DIGITAL logo is displayed, followed by MS-Windows.

5. Turn off your workstation.

6. Remove your key diskette if you do not want anyone else to access your files.

   If you try to close MS-Windows while an MS-Windows application such as Notepad is still running, MS-Windows displays a dialog box and lets you save the updated data file.

   If you try to close MS-Windows while a standard application is still running, MS-Windows displays a dialog box indicating an application is still running. The name of the active application is displayed in the title bar of the dialog box. Close the identified application, then close MS-Windows again.
Deleting More Than One File

To delete more than one file at a time, select all the files you want to delete, then follow steps 2 and 3 in the previous section.

Printing a Text File

To print text files, select the Print command from the File menu. With the Print command, you can print any files you can display on your screen.

NOTE

Most applications have a command that prints files you create with that application. You should use the application command when possible.

To print a file:

1. Click on the file name of the text file you want to print.
   The file name you selected is highlighted.
2. Select the Print command from the File menu.
   MS-Windows displays the Print dialog box. Figure 4-3 shows the Print dialog box.

   ![Print Dialog Box](image)

   **Figure 4-3  Print Dialog Box**

   If the file name is not the one you want to print, type the correct file name over the one displayed. You must type the entire file name, including any file extension.
3. Click on the Ok command button.

The MS-DOS Executive window displays the Print Spooler dialog box, telling you the file is being sent to the Spooler for the default printer. Figure 4-4 shows the Print Spooler dialog box.

![Print Spooler Dialog Box](image)

**Figure 4-4  Print Spooler Dialog Box**

**NOTE**

Printing does not start until the file has been sent to the Print Spooler. The length of the delay before the printer starts depends on the complexity and length of the file you are printing.

For more information about the default printer and how to select it, see Chapter 8.

To cancel the print request, click on the Cancel command button.

**Using the Spooler**

The MS-Windows Spooler is an application that stores files waiting to be printed. When you execute the Print command from the MS-DOS Executive or from a Desktop application:

- The Spooler application starts.
- The Spooler icon is displayed in the icon area.
- A file is sent to the Spooler application.
- The Spooler starts to print the file on your printer, if no other files are printing.
Changing How File Names Are Listed

The View menu commands change how file names are listed in the MS-DOS Executive window.

When you first start MS-Windows, the files in the MS-DOS Executive window are listed in alphabetical order. The directory names are at the top of the list. However, you can list files in a different order, such as by size or by the date they were created or changed. You can also list files having the same file extension.

To see only files having the same file extension, you must specify the file extension. To specify the type of files you want to view, use the Partial command.

To view a partial list of files:

1. Select the Partial command from the View menu.

   MS-Windows displays the Partial dialog box. Figure 5-3 shows the Partial dialog box.

   ![Partial Dialog Box]

2. In the text box, type the file names you want to see.

   Use wildcard characters (‘ or ?) to tell MS-Windows which kind of file to display. For example, to display all file names with the file extension .EXE, type *.EXE in the text box.

3. Click on the Ok command button.
Displaying Multiple Directories

You can display more than one MS-DOS Executive window at a time. This is useful for displaying two different directories at the same time, one directory in each MS-DOS Executive window.

To display a second MS-DOS Executive window:

1. Use the Run command to open the second MS-DOS Executive window.
   The file name is MSDOS.EXE.
2. In the new MS-DOS Executive window, double-click on the directory path name you want to display.
   The selected directory is displayed in the second MS-DOS Executive window. Two different directories are displayed, one directory in each MS-DOS Executive window.

If you display the same directory in multiple windows, only the directory in the active window is updated when you create, delete, rename, or copy a file. To update the listing in an inactive window, move the mouse to that window and click on the highlighted drive icon.

Printing a Directory Listing

To print a directory listing, use the Print command. The directory listing is printed as it is displayed in the MS-DOS Executive window.

To print a directory listing:

1. Click on the directory name.
2. Select the Print command from the File menu.
   MS-Windows displays the Print dialog box.
3. Click on the Ok command button.
   The listing of the selected directory is printed.
3. Click on the option button of the disk drive containing the new diskette.

4. Click on the Ok command button.
   The system displays a warning that any data on the diskette in the drive will be destroyed.

5. Click on the Ok command button to continue or click on the Cancel command button to stop.

### Preparing a System Diskette

A system diskette contains the files necessary for starting the MS-DOS operating system.

To prepare a system diskette:

1. Prepare a diskette by using the Format Data Disk command.
2. Ensure the new diskette is in the disk drive to which you want to copy.
3. Select as your current drive a drive that contains the system files.
4. Select the Make System Disk command from the Special menu.
   MS-Windows displays the Make System Disk dialog box.
5. Click on the option button of the disk drive to which the MS-DOS system files are to be copied.
6. Click on the Ok command button.

   Copying starts when you click on the Ok command button. While the MS-DOS system files are being copied, the dialog box remains on the screen and the arrow changes to an hourglass.

   When complete, the dialog box is removed from the screen, and the hourglass changes to the arrow.
Naming Disks

To assign a name (a volume name) to a diskette, use the Set Volume Name command. The volume name identifies the contents of the disk.

To name a disk:

1. Click on the symbol of the disk drive containing the disk you want to name.
2. Select the Set Volume Name command from the Special menu.

MS-Windows displays the Volume Name dialog box, containing the current name if any exists. Figure 5-5 shows the Volume Name dialog box.

![Volume Name Dialog Box](image)

Figure 5-5  Set Volume Name Dialog Box

3. In the text box, type a name.

   Only the first twelve characters are accepted.

4. Click on the Ok command button.

   The new volume name for the disk is displayed to the right of the drive letter in the path name.
Continue pressing the arrow keys to move beyond the window border to the size you want. A line shows where the new window's border is located.

To make the window smaller, you must move the size box beyond the window border and back inside the window border.

4. Press the Return key.

MS-Windows changes the size of the window and adjusts the size of any adjacent windows.

Making a Window Fill the Entire Screen

To zoom a window so that it fills the entire screen:

1. Switch to the window you want to fill the entire screen.
2. Select the Zoom command from the System menu.

   The window you selected zooms and fills the entire screen including the icon area.

To zoom a window, you can also:

1. Switch to the window you want to fill the entire screen.
2. Press the Alt/Return keys.

   The window you selected zooms and fills the entire screen including the icon area.

To return the window to its former size:

- Use the Zoom command again.
- Press the Alt/Return keys to restore the window to its former size.

Moving a Window

To move a window to another position in the work area:

1. Switch to the window you want to move.
2. Select the Move command from the System menu.

   MS-Windows displays the icon of the application in the middle of the window.
Using the Keyboard

3. Press the arrow keys until the icon is where you want the window to be moved.

4. Press the Return key.

   The window is moved to the position you selected. MS-Windows adjusts the size of the other windows in the work area.

Receiving Messages From Another Application

To see a message sent by another application, switch to the window whose title bar is flashing or to the flashing icon:

   1. Hold the Alt key and press the Tab key until the window or icon of the application sending you the message is highlighted.

   2. Release the Alt key.

   The message is displayed when you switch to the window or icon of the application sending you the message.

Printing Screen Images

With MS-Windows, you can send the information displayed on the screen to your printer, on LPT1. To print a screen, the GRAPHICS command must be loaded and run before MS-Windows starts. The key diskette runs the GRAPHICS command for you. For more information on the GRAPHICS command see Chapter 32.

To print your screen:

   1. If you are using a local printer, be sure your printer is attached and on line.

   2. Ensure the screen contains the information you want printed. Everything displayed on the screen is printed.

   3. Press Shift/Prt Sc.

      The screen is printed. This operation may take a few minutes.

      NOTE
      Do not press Shift/Prt Sc if LPT1 is being used by another application.
Chapter 7
Running
Standard Applications

This chapter describes how to:

• Run standard applications in a window
• Run standard applications outside a window
• Transfer information between standard applications
• Run large standard applications
• Run special applications

Working with Standard Applications

A standard application is an application (with a .EXE, .BAT, or .COM extension) that you can use with MS-Windows, even though it was not designed for this use. (MS-Windows applications, such as Notepad and Clock, are specifically designed to be used with MS-Windows.)

When you run a standard application with MS-Windows, you continue to use the commands and functions of the application. For many standard applications, MS-Windows lets you run several applications and switch from one application to another.

Many standard applications can run in a window, sharing the work area with other applications in their own windows. However, some standard applications require the entire screen and run outside a window.

Whether a standard application runs in a window depends on how it:

• Uses memory
• Processes input/output (I/O) activities
Running Standard Applications

When an application runs on your workstation, it processes I/O activities that use the workstation’s resources. These resources include:

- Computer memory
- Communications ports
- Video display screen
- Keyboard

If a standard application uses standard MS-DOS supplied I/O procedures and memory allocation, it can run in a window, because MS-Windows emulates the I/O activities that are compatible for MS-DOS.

If a standard application does not use standard MS-DOS supplied I/O procedures or standard memory allocation, it cannot run in a window, because MS-Windows cannot provide the interface for I/O activities. These standard applications provide their own interface for I/O activities.

**NOTE**
Standard applications must run under MS-DOS Version 3.10 or later to run from MS-Windows.

Using Program Information Files

A program information file (PIF) contains information about how a standard application uses workstation resources. The system administrator enters this information into a PIF for the standard application, and the information is used by MS-Windows. Each standard application you use should have a PIF associated with it.

Included with your MS-Windows software package are PIFs for many standard applications. If you try to run an application that has no PIF, MS-Windows uses default settings for the resources. However, the system administrator should create a PIF for the application.

An application can have more than one PIF associated with it. For example, you can have two versions of the same application. One version can require a large amount of memory, because you use all the features of the application, while another version can require less memory, because you use only a few features.
Some applications *require* more than one PIF. Each file with a .EXE, .COM, and .BAT extension that an application runs must have a PIF associated with it.

If you are running a batch file (an application with a .BAT extension) that redirects I/O, you must set the Directly Modifies Screen option in its PIF file and run it from the MS-DOS Executive window. See Appendix C for more information on creating PIFs for standard applications.

**NOTE**
You should not run a batch file from a COMMAND.COM window if the file includes redirected I/O or piping.

You can run an application by selecting its PIF in the MS-DOS Executive window. When you select the PIF, MS-Windows loads and runs the application named in the PIF.
This page intentionally left blank.
When you paste information to a terminal emulator, you must first enable HOSTSYNC under VMS by typing:

```
$ SET TERMINAL/HOSTSYNC
```

This command prevents data overruns.

You cannot paste:

- Information from the Clipboard to an application that runs outside a window
- Graphics information from the Clipboard to any standard application (inside or outside a window)

**NOTE**

Text is stored in its character (ASCII) representation. When you use the Copy or Paste commands, the text is also transferred in this character representation.

To use the Paste command:

1. Switch to the window into which you want to paste the information.
2. Move the cursor where you want to insert the information.
3. Select the Paste command from the System menu.

   The selected text is inserted in your application at the cursor location.

**Using the Prt Sc Key**

You can also transfer information to the Clipboard by using the Alt/Prt Sc keys. To copy a standard application's window to the Clipboard:

1. To copy from a standard application that runs in a window, make sure the window is the active window. (Switch to the window you want to copy if it is not the active window.)

2. Press the Alt/Prt Sc keys.

   For a standard application that runs outside a window, the screen contents are copied to the Clipboard. For a standard application that runs in a window, the active window is copied, as if it filled the entire screen, to the Clipboard. Other windows in the work area are not copied.
Running Standard Applications

A block of information, 80 columns by 25 lines, is transferred from the selected window to the Clipboard, regardless of the number of columns and lines displayed in the window.

After the information has been copied to the Clipboard, you can paste it to other applications with the Paste command.

Running Large Standard Applications

To run multiple standard applications efficiently, run the largest application first.

If you run more than one application and try to run a new application that requires more memory than is available, MS-Windows displays the message "Not enough memory to run."

If you see this message, close an application that you do not currently need and try to run the standard application again.

If you are closing a standard application, you should first execute the Exit command of the application.

The application runs after enough memory has been freed by closing other applications. If the MS-DOS Executive window is the only application running, the application you selected runs because MS-Windows and the MS-DOS Executive application step aside and give the application most of the available memory. A small amount of memory is retained for restoring MS-Windows.

When you finish using the large application, close it. After you close the application, the MS-DOS Executive window returns to the work area. Any application defined in the WIN.INI file to load or run is started.

NOTE
Do not use a large standard application in the WIN.INI file's RUN= line.

Running Special Applications

Some applications remain in memory after you load them. These special applications are sometimes called "memory resident," "terminate and stay resident," or "pop-up" programs.

You must load special applications before you start MS-Windows.
You run special applications from MS-DOS outside MS-Windows. You can also run special applications while using standard applications that both:

- Do not run in a window
- Have Directly Modifies Memory set in their PIFs

You cannot run special applications from COMMAND.COM in MS-Windows.

**NOTE**
The PIF for a special application should have the Directly Modifies Memory option enabled. If you then try to run a special application, a system warning displays. Select CANCEL. If you select Ok, the special application can cause system problems.

Some special applications prevent you from switching back to MS-Windows. To return to MS-Windows, stop the special application by using its EXIT command.
After MS-Windows is set up, you can add a printer driver file to MS-Windows when you want to install:

- An existing printer driver file
  
  The printer driver file is included in the network directory H:\WIN\UTIL, which stores printer driver files.

- A new printer driver file
  
  The printer driver file is not in the network directory H:\WIN\UTIL. You install the printer driver file by copying it from the distribution diskette of a new application to the network directory H:\WIN\UTIL.

After you add a new printer to your system, you must let MS-Windows know which communications port the printer is connected to before you can use the printer. To define the communications port, use the Connections command in the Setup menu of the Control Panel.

Adding an Existing Printer Driver File

To add an already existing printer driver file to your system:

1. Select the Add New Printer command from the Installation menu.

   MS-Windows displays the Add Printer dialog box. Figure 8-4 shows the Add New Printer dialog box.

   ![Add Printer Dialog Box](image)

   **Figure 8-4 Add Printer Dialog Box**

2. In the text box, you type the location of the printer driver file, typically:
   
   H:\WIN\UTIL
3. Select the Ok command button.

MS-Windows displays a dialog box, listing the printers available in the directory you specify.

4. From the list box, select a printer.

The name of the corresponding printer driver file is displayed in the Printer File text box of the dialog box.

See Table 8-1 for information on selecting the LA75 and the LN03 PLUS printers.

5. Select the Add command button.

MS-Windows displays a dialog box.

6. Select the No command button.

Selecting the No command button is the normal procedure. However, if you want to duplicate this printer driver file, type the drive or name of an existing directory you want, and select the Yes command button.

MS-Windows updates the WIN.INI file to include information for the new printer driver. However, only the WIN.INI file used when you start MS-Windows is updated. If the printer is added to the network and is used by more than one user, the WIN.INI file of each user needs to be updated.

**Table 8-1 Selecting Printers**

<table>
<thead>
<tr>
<th>Type of Printer</th>
<th>Select</th>
<th>Driver filename is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>LA75</td>
<td>Digital LA75DEC</td>
<td>LA50.DRV</td>
</tr>
<tr>
<td>LN03 PLUS with CG-Times Cartridge</td>
<td>Digital LN03PLUS</td>
<td>LN03PLUS.DRV</td>
</tr>
<tr>
<td>LN03 PLUS with ISO/PC Cartridge</td>
<td>Digital LN03DEC</td>
<td>LN03PLUS.DRV</td>
</tr>
<tr>
<td>LA75 to emulate IBM Proprinter</td>
<td>LA75STD</td>
<td>LA75.DRV</td>
</tr>
<tr>
<td>LN03 PLUS with ISO/PC Cartridge to emulate IBM Proprinter</td>
<td>Digital LN03STD</td>
<td>LA75.DRV</td>
</tr>
</tbody>
</table>
Adding a New Printer Driver File

Your system administrator adds new printer driver files from the distribution diskette that comes with a new printer. This section includes information your system administrator needs to add a new printer driver file.

To add a new printer driver file to the directory containing the other MS-Windows printer driver files:

1. Select the Add New Printer command from the Installation menu.

   MS-Windows displays a dialog box that prompts you to insert into Drive A the diskette with the printer driver file you want to add, or to select an alternate drive/directory. It displays H:\WIN\UTIL in the text box. Select Drive A by typing in the text box:

   A:\

2. Insert the diskette with the printer files.

   See the printer hardware documentation to determine which diskette and which directory contains the printer driver files (.DRV).

3. Select the Ok command button.

   MS-Windows displays a dialog box, listing the printers available on the diskette.

4. From the list box, select a printer.

   After you select a printer, the name of the corresponding printer driver file displays in the printer file text box at the right.

5. Select the Add command button.

   A dialog box prompts you for the name of the drive or directory to which you want to copy the printer driver file.

6. In the text box, type the alias for H:\WIN\UTIL, the drive and directory to which the printer driver file is to be copied. Drive H: must be connected to the read/write alias for the system files.

7. Select the Yes command button.

   MS-Windows updates the WIN.INI file to include information for the new printer driver. However, only the WIN.INI file used by MS-Windows when you started MS-Windows is updated. If the printer is added to the network, and is used by more than one user, the WIN.INI file of each user needs to be updated.
Removing a Printer

To remove a printer from MS-Windows:

1. Select the Delete Printer command from the Installation menu.

   MS-Windows displays the Delete Printer dialog box. The list box shows all the printers currently in your WIN.INI file. Figure 8-5 shows the Delete Printer dialog box.

   ![Delete Printer Dialog Box](image-url)

   **Figure 8-5 Delete Printer Dialog Box**

2. Select the printer you want to remove from the list box.

   The file name of the corresponding printer driver file is displayed in the text box.

3. Select the Delete command button.

   MS-Windows displays a dialog box.

4. Select the No command button.

   **NOTE**

   When you select the No command button, the printer name is deleted from the WIN.INI file, but the printer driver file is not. By selecting the No command button, you can use the procedure discussed in “Adding an Existing Printer Driver File,” because the printer driver is still stored in the directory.
It is recommended that you do not delete the printer driver file. If you select the Ok command button, the printer driver file is deleted from the network directory H:\WIN\UTIL. To add the printer driver file again, you must follow the more complicated procedure discussed in "Adding a New Printer Driver File."

Some printer drivers support more than one printer model. In this case, the printers share the print driver file. If other printers share the printer driver file that is displayed in the Delete Printer dialog box, that printer driver file is not deleted, because it is still used by the other printers.

In this case, MS-Windows displays a dialog box, indicating the shared printer driver file is not deleted. However, it is disassociated from the selected printer in the WIN.INI file.

**Adding a New Font**

To add a font file (.FON) to MS-Windows, use the Add New Font command from the Installation menu. This command works similarly to the Add New Printer command.

When you select the Add New Font command (or the Delete Font command), you must specify where the font files are located. MS-Windows lists the available fonts, including the font names, the font sizes, and the set numbers.

The set number is based on the devices that the font is primarily designed to be used with.

*Set 1*

Set 1 fonts are stroke fonts. They can be used for the screen, a printer, or a plotter device of any resolution.

*Set 2*

Set 2 fonts are raster fonts. They are designed for a screen resolution of 640 × 200, such as a workstation with the IBM Color Graphics Adapter or compatible adapter card.
Using the Control Panel

Set 3
Set 3 fonts are raster fonts. They are designed primarily for a screen resolution of $640 \times 350$, such as a workstation with an IBM Enhanced Color Graphics Adapter or Hercules Graphics Card. These fonts are also used by VAXmate.

Set 4
Set 4 fonts are raster fonts. They are designed primarily for printers in 60 dpi resolution:

- LA75 in STD mode (landscape mode)
- Okidata 92, 93, 192, 193, standard models (portrait mode)
- Okidata 92, 93, 192, 193, standard and IBM-compatible models (landscape mode)
- Epson MX-80, FX-80, and compatibles (landscape mode)
- IBM Graphics (landscape mode)
- IBM Proprinter (landscape mode)
- Star Micronics SG-10 (landscape mode)

Set 5
Set 5 fonts are raster fonts. They are designed for printers in the 120 dpi resolution:

- LA75 in STD mode (portrait mode)
- Okidata 92, 93, 192, 193, IBM-compatible models (portrait mode)
- Epson MX-80, FX-80, and compatibles (portrait mode)
- IBM Graphics (portrait mode)
- IBM Proprinter (portrait mode)
- Star Micronics SG-10 (portrait mode)

In addition to these fonts, an application can list device fonts. These are the fonts provided by a device. For example, on print-wheel printers, font names correspond to wheel names. These fonts cannot be added or deleted with the Control Panel, but they can be listed when the output device is selected. When a raster font does not correspond to the screen, MS-Windows can substitute a screen font in the same class.

8.12
NOTE
Because applications handle fonts differently, some applications may not list all fonts.

Fonts have names that represent their different characteristics. Table 8-2 lists and describes the fonts that are included on H:\WIN\UTIL.

Table 8-2 Fonts on the Fonts Disk

<table>
<thead>
<tr>
<th>Font</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DECterm</td>
<td>(Raster font.) A fixed-width font (characters having uniform widths) without serifs.</td>
</tr>
<tr>
<td>Helv</td>
<td>(Raster font.) A proportional font (characters having varying widths) without serifs.</td>
</tr>
<tr>
<td>Courier</td>
<td>(Raster font.) A fixed-width font with serifs.</td>
</tr>
<tr>
<td>Tms Rmn</td>
<td>(Raster font.) A proportional font with serifs.</td>
</tr>
<tr>
<td>Roman</td>
<td>(Stroke font.) A proportional font with serifs.</td>
</tr>
<tr>
<td>Modern</td>
<td>(Stroke font.) A proportional font without serifs.</td>
</tr>
<tr>
<td>Script</td>
<td>(Stroke font.) A proportional font of slanted characters formed from nearly continuous curved lines.</td>
</tr>
</tbody>
</table>

Table 8-3 describes the fonts that are not included on H:\WIN\UTIL, but you can see them in some applications. These fonts cannot be added or deleted.

Table 8-3 Fonts Not on the Fonts Disk

<table>
<thead>
<tr>
<th>Font</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>(Raster font.) A fixed-width font designed for the screen.</td>
</tr>
<tr>
<td>Terminal</td>
<td>(Raster font.) A fixed-width font that is the same as the font your workstation displays from MS-DOS.</td>
</tr>
</tbody>
</table>

Deleting a Font

To delete a font file to MS-Windows, use the Delete Font command from the Installation menu. This command works similarly to the Delete Printer command.
Using the Control Panel

Using the Setup Menu

The Setup menu has four commands:

- Connections, which lets you assign or change printer port connections
- Printer, which lets you select the default printer
- Communications Port, which lets you select a serial communications port and select parameters, such as baud rate, word length, parity, and stop bits
- Network Terminal Services, which lets you select network services for your communication ports

Figure 8-6 shows the Setup menu commands.

![Control Panel Setup Menu Commands](image)

Changing Printer Connections

MS-Windows needs to know to which communications port your printer is connected. To set or change the port for your printers, use the Connections command.

For example, to move your printer from the communications port LPT1 to LPT2, use the Control Panel to change the printer connections setting.
To change printer connections:

1. Select the Connections command from the Setup menu. MS-Windows displays the Connections dialog box. Figure 8-7 shows the Connections dialog box.

2. From the Printer list box, select the printer you want to change. The current communications port assignment for the selected printer is displayed in the Connection list box, located at the right.

3. From the Connections list box, select one of the communications ports.

4. Select the Ok command button.

**NOTE**
You can redirect an LPT port only to the SPP (Serial Printer Port) or to a network print device.

### Changing the Default Printer

When you execute a Print command, MS-Windows prints the file on the default printer. To select the default printer and to set its output modes, use the Printer command.

Printer output modes are printer-specific settings, such as portrait mode (normal vertical page orientation) or landscape mode (horizontal page orientation). The Printer command is useful when you have both local and remote printers, or both dot matrix and character printers, connected to your communications ports.
Using the Control Panel

To change the default printer:

1. Select the Printer command from the Setup menu.

   MS-Windows displays the Default Printer dialog box. It lists all the available printers and their current communications port connections. Figure 8-8 shows the Default Printer dialog box.

   ![Default Printer Dialog Box](image)

   **Figure 8-8  Default Printer Dialog Box**

2. From the list box, select the printer name.

3. Select the Ok command button.

   MS-Windows displays the Output Mode dialog box, containing the mode settings specific to the printer you selected.

4. To select another output mode, select from the options for printer output or answer the questions in the dialog box.

5. Select the Ok command button.

   The printer you select becomes the default printer.

Changing the Communications Port

To select COM1 and COM2 settings, including baud rate, stop bits, parity, word length, and the retry (print/send) option, use the Communications Port command.

For example, MS-Windows' print spool uses these settings to configure the communication port before printing. (COM1 and COM2 are serial communications ports and can be used only with serial printers and serial communication devices.)
To select a communications port:

1. Select the Communications Port command from the Setup menu.

   MS-Windows displays the Communication Settings dialog box. Figure 8-9 shows the Communications Settings dialog box.

2. Select the communications port COM1 or COM2.

   The settings for the selected communications port are displayed in the dialog box.

3. Select the rest of the settings.

   The settings for baud rate, word length, stopbits, and handshake (protocol) should be the same as those set for your printer or device. The protocol, "Hardware," is equivalent to XON/XOFF. See your printer or device documentation for the proper communications port settings.

4. Select the Ok command button. The communications port you select is set up.

   **NOTE**

   This command does not configure or set up the communication hardware. It gives information about the communication hardware settings to MS-Windows and the applications using the communications ports. When you set up a communications device or printer, make sure the communications port settings are configured according to the serial communications instructions supplied by your printer or device manufacturer before you try to print.

   **Figure 8-9 Communications Settings Dialog Box**
Selecting Network Terminal Services

To select terminal services for the workstation’s communication ports, use the Network Terminal Services command. This command lets you redirect the COM1 and COM2 communications ports to the selected terminal services. Any application using COM1 or COM2 is redirected over the local area network to the specified network terminal service.

To select a network terminal service:

1. Select the Network Terminal Services command from the Setup menu.

   MS-Windows displays a Network Terminal Services dialog box. It lists the currently available network services. Figure 8-10 shows the Network Terminal Services dialog box.

   **Figure 8-10  Network Terminal Services Dialog Box**

   *NOTE*
   For most systems, you can access a maximum of 10 services. A warning box is displayed if the service table has overflowed.

   To add more services, you must change the table size in the Network Terminal Services (LAT) driver.

2. From the Port list box, select the COM1 or COM2 communications port.

   The current terminal services for that port are displayed.
3. From the Services list box, select a terminal service.

4. Select the Ok command button.

You can redirect communications ports to a network terminal service for any standard application that runs in a window, such as, the VT220 terminal emulator. Using the configuration shown in Figure 8-10, you can connect the VT220 emulator to the COM2 port; however, all communications for the VT220 emulator will use the network terminal service called RANGER. For more information about network terminal services, see Chapter 9.

When you run an application that uses COM1 or COM2, the selected terminal service is redirected if the following conditions are met:

- The Network Terminal Service driver (LAT) was installed prior to starting MS-Windows. This driver lists all available services, normally assigned by the key diskette.

- The redirected port is COM1 or COM2. Only COM1 and COM2 can be redirected.

- The mode of transmission is computer to computer, and does not use a modem. Only applications that do not use modem control signals to control the flow of data can be redirected.

- No more than four Network Terminal Services are active, including redirected and direct connections.

- A terminal services name is present in the WIN.INI file for the serial communication device being used. You cannot select a terminal service not listed in the Services list box.

- The terminal service is available. This availability is dynamic. If a terminal service is selected for a communications port, the terminal service is assigned to that communications port only as long as terminal service is available to the network. If the terminal service becomes unavailable to the network, it is no longer assigned to the communications port.

**NOTE**

Even if COM1 and COM2 hardware is not installed, redirection over the local area network can occur, because the redirection is done by software.
Using the Preferences Menu

The Preferences menu has four commands:

- Screen Colors, which lets you adjust shades on your screen
- Keyboard Settings, which lets you change settings such as keyclick and autorepeat
- Mouse, which lets you swap the function of the left and right mouse buttons
- Country Settings, which lets you select country-specific user preferences

Figure 8-11 shows the Preferences menu commands.

![Figure 8-11 Preferences Menu Commands](image)

Changing Screen Colors

To adjust the shades of the components in a window, use the Screen Colors command. These components are:

- Window background
- Window text
- Scroll bars
- Active (selected) title bar
- Inactive (unselected) title bar
- Title bar text
- Window frame (the thin border around the outside of the window)
To change the shade of a component in a window:

1. Select the Screen Colors command from the Preferences menu.

MS-Windows displays the Screen Colors dialog box. Figure 8-12 shows the Screen Colors dialog box.

**NOTE**
Set your screen to have contrasting text and background colors. Otherwise, your screen could look blank.

2. From the Screen Colors list box, select the part of the screen for which you want to change the shade.

The current settings for Hue, Bright, and Color of the selected component in the window are displayed in the scroll bars. The mixture of these three settings for the selected component result in the current shade displayed in the Sample area.

To change the shade of a component in the window, change the settings for Hue, Bright, and Color.
Using the Control Panel

3. To change a setting for Hue, Bright, or Color:
   a. Move the cursor to the scroll bar by clicking on the scroll bar or by pressing the Tab key until the scroll box blinks in the desired scroll bar.
   b. Scroll to the right or to the left to change the setting.
      With the mouse, click on the arrows or drag the scroll box in the scroll bar.
      With the keyboard, press the right and left arrow keys to change settings in small increments, or press the Pg Up or Pg Dn keys to move across the scroll bar more quickly.
      As you scroll, the Sample area dynamically shows the changing shade of the selected window component.
   c. Select another scroll bar until the desired shade is displayed in the Sample area.
   d. Change the shades of all other items in the Screen Colors dialog box.
   e. When you finish changing screen colors, select the Ok command button.
      When you select the Ok command button, the settings are recorded in the WIN.INI file, and the dialog box is removed from the screen.

Changing Keyboard Settings

To change keyboard features, use the Keyboard Settings command. These features include:

- Keyclick volume (No sound, Soft, Intermediate, Loud)
  The default setting is Intermediate.
- Autorepeat (enable or disable)
  The default setting is autorepeat enabled.
- Lock selection (Caps Lock or Shift Lock)
  The default setting is Caps Lock.
  This selects the function of the Lock key.
Scrolling in the Emulator Window

If you need to view more information than can be displayed in an emulator window, use these keys:

- Ctrl/Find - To scroll to the left
- Ctrl/Select - To scroll to the right
- Ctrl/Prev - To scroll up
- Ctrl/Next - To scroll down

Using the VT220 Emulator System Menu Commands

The VT220 emulator adds the following commands to the standard System menu commands:

- Set-Up
- Mark
- Copy
- Paste
- About

The Set-Up Command

You can start or exit from the VT220 emulator Set-Up utility by selecting the Set-Up command. Chapter 12 discusses the Set-Up utility.
Using the VT220 Terminal Emulator

The Mark, Copy, and Paste Commands

The VT220 emulator lets you transfer information between itself and the MS-Windows Clipboard application. You copy the information from the emulator to the Clipboard or paste information from the Clipboard to the emulator as if you typed it. When you send information to the Clipboard, the characters are interpreted as ISO Latin-1 characters.

To copy text to the Clipboard:

1. Select Mark from the VT220 System menu.

   The word “Mark” is displayed in parentheses next to the VT220 emulator title in the title bar. A special vertical bar, the insertion point, is also displayed in the window.

2. Drag the insertion point across the text you want to copy. This marks the text.

3. Select Copy to move the marked text to the Clipboard.

   NOTE
   Marking is disabled whenever a key is typed, or when Mark is selected a second time.

You can paste from the Clipboard at any time. The pasted text is sent to the host. Text is not displayed in the window unless the host echoes it, or Local Echo is enabled in Set-Up.

The About Command

The About command displays the version number of the VT220 emulator application.

Leaving the VT220 Emulator

To leave the VT220 emulator select one of the following commands from the VT220 System menu:

- The Icon command

  Selecting the Icon command shrinks the VT220 emulator to an icon without exiting from the emulator application.

- The Close command

  Selecting the Close command exits you from the VT220 emulator. Before using this command, you should log off the host system.
Using Set-Up With the VT220 Emulator

### Table 12-4 VT220 Display Set-Up (cont.)

<table>
<thead>
<tr>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Cursor</td>
<td>Selects whether to display a text cursor.</td>
</tr>
<tr>
<td>Visible</td>
<td>Displays the cursor.</td>
</tr>
<tr>
<td>(default)</td>
<td></td>
</tr>
<tr>
<td>Invisible</td>
<td>Does not display the cursor.</td>
</tr>
<tr>
<td>Auto Wrap</td>
<td>Selects whether text automatically wraps on the screen.</td>
</tr>
<tr>
<td>On</td>
<td>Causes characters that reach the right margin to automatically be displayed in the first character position of the next line.</td>
</tr>
<tr>
<td>Off (default)</td>
<td>Causes characters that go beyond the right margin to overwrite the last character position of the current line.</td>
</tr>
<tr>
<td>Cursor Style</td>
<td>Selects the text cursor style.</td>
</tr>
<tr>
<td>Block (default)</td>
<td>Displays block cursor.</td>
</tr>
<tr>
<td>Underline</td>
<td>Displays underline cursor.</td>
</tr>
<tr>
<td>Background</td>
<td>Selects the screen display type.</td>
</tr>
<tr>
<td>Light (default)</td>
<td>Selects reverse video screen display (dark text on a light background).</td>
</tr>
<tr>
<td>Dark</td>
<td>Selects a dark screen display (light text on a dark background).</td>
</tr>
<tr>
<td>Blink</td>
<td>Blinking display is not implemented for the VT220 emulator.</td>
</tr>
<tr>
<td></td>
<td>You have a choice of displaying characters with blinking attributes as either normal video (default), reverse video, or underscore.</td>
</tr>
<tr>
<td>Font Size</td>
<td>Changes the font size of characters displayed on the screen. The settings are: Normal (default), Small, or Automatic.</td>
</tr>
<tr>
<td></td>
<td>If you are using applications that display more than 80 columns, use the Automatic or Small setting.</td>
</tr>
</tbody>
</table>
Using Set-Up With the VT220 Emulator

General Screen

The General Set-Up screen lets you define a group of commonly used general operating settings.

![General Set-Up Screen](image)

**Table 12-5 VT220 General**

Table 12-5 defines the General Set-Up selections and, where applicable, the settings.

Receive File: Idle
Send File: Idle
Printer: None
Modem: Not Selected
Telephone: Talk Mode - Manual Answer
Insert/Replace: Replace
Communications: Comm Port 1 - Data Leads Only
**Saving Changes**

To save changes to the current file, use the Save command from the File menu.

Calendar replaces the file on the disk with the current file.

**Printing Appointments**

To print appointments:

1. Select the Print command from the File menu.

   Calendar displays the Print dialog box. Figure 20-5 shows the Print dialog box.

   ![Print Dialog Box](image)

   **Figure 20-5  Print Dialog Box**

2. In the From text box, type the first date you want to print.
3. Press the Tab key to move the cursor to the To text box.
4. Type the last date you want to print.

   To print a single date's appointments, leave the To text box blank.
5. Select the Ok command button.

   Calendar prints the text for the selected dates.
Using Calendar

Removing Appointment Dates

You can delete a single date or a range of dates to make room for other dates on your disk.

To remove appointment dates:

1. Select the Remove command from the File menu.

   Calendar displays the Remove dialog box. Figure 20-6 shows the Remove dialog box.

   ![Remove Dialog Box]

   Figure 20-6 Remove Dialog Box

2. In the From text box, type the first date you want to remove.

3. In the To text box, type the last date you want to remove.

   To remove a single date’s appointments, leave the To text box blank.

4. Select the Ok command button.

   Calendar removes the text for the dates you selected.

Deleting a File

You can delete a file to make room for other files on your disk. To delete a file, use the Delete command from the File menu.
Table A-2  Valid Compose Sequences  (cont.)

<table>
<thead>
<tr>
<th>Character</th>
<th>Two-Key Sequence</th>
<th>Three-Key Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>« (angle quotes left)</td>
<td>&lt;&lt;</td>
<td></td>
</tr>
<tr>
<td>» (angle quote right)</td>
<td>&gt;&gt;</td>
<td></td>
</tr>
<tr>
<td>NBSP (No Break Space) •</td>
<td>(sp)(sp) (Two spaces)</td>
<td></td>
</tr>
<tr>
<td>i (inverted !)</td>
<td>!!</td>
<td></td>
</tr>
<tr>
<td>ï (inverted ?)</td>
<td>??</td>
<td></td>
</tr>
<tr>
<td>° (degree sign)</td>
<td>0° or ° (sp)</td>
<td></td>
</tr>
<tr>
<td>© (copyright sign)</td>
<td>co</td>
<td></td>
</tr>
<tr>
<td>® (reg. trademark) •</td>
<td>ro</td>
<td></td>
</tr>
<tr>
<td>¢ (cent sign)</td>
<td>c/ or c</td>
<td></td>
</tr>
<tr>
<td>£ (pound sign)</td>
<td>l= or l=</td>
<td></td>
</tr>
<tr>
<td>&quot; (general currency)</td>
<td>xo</td>
<td></td>
</tr>
<tr>
<td>¥ (yen sign)</td>
<td>y= or y=</td>
<td></td>
</tr>
<tr>
<td>– (soft hyphen) •</td>
<td>– –</td>
<td></td>
</tr>
<tr>
<td>” (macron sign) •</td>
<td>_^ or ^</td>
<td></td>
</tr>
<tr>
<td>μ (micro sign)</td>
<td>/u</td>
<td></td>
</tr>
<tr>
<td>¬ (logical NOT sign)</td>
<td>–, (order sensitive)</td>
<td></td>
</tr>
<tr>
<td>± (plus/minus sign)</td>
<td>±</td>
<td></td>
</tr>
<tr>
<td>× (multiply sign)</td>
<td>xx</td>
<td></td>
</tr>
<tr>
<td>÷ (divide sign)</td>
<td>–: (order sensitive)</td>
<td></td>
</tr>
<tr>
<td>1 (superscript 1)</td>
<td>1^</td>
<td></td>
</tr>
<tr>
<td>2 (superscript 2)</td>
<td>2^</td>
<td></td>
</tr>
<tr>
<td>3 (superscript 3)</td>
<td>3^</td>
<td></td>
</tr>
<tr>
<td>¶ (paragraph sign)</td>
<td>!p</td>
<td></td>
</tr>
<tr>
<td>§ (section sign)</td>
<td>so or s!</td>
<td></td>
</tr>
<tr>
<td>† (feminine ordinal)</td>
<td>_a or _A</td>
<td></td>
</tr>
<tr>
<td>‡ (masculine ordinal)</td>
<td>_o or _O</td>
<td></td>
</tr>
<tr>
<td>• (middle dot)</td>
<td>^</td>
<td></td>
</tr>
</tbody>
</table>
### Creating Alternate Characters

**Table A-2  Valid Compose Sequences (cont.)**

<table>
<thead>
<tr>
<th>Character</th>
<th>Two-Key Sequence</th>
<th>Three-Key Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/4 (fraction one-quarter)</td>
<td></td>
<td>14 (order sensitive)</td>
</tr>
<tr>
<td>1/2 (fraction one-half)</td>
<td></td>
<td>12 (order sensitive)</td>
</tr>
<tr>
<td>3/4 (fraction three-quarters) *</td>
<td></td>
<td>34 (order sensitive)</td>
</tr>
<tr>
<td>š (German sharp s)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ø (cap Icelandic Eth) *</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ð (sm Icelandic Eth) *</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ø (O slash)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ø (o slash)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>þ (cap Icelandic Thorn) *</td>
<td></td>
<td></td>
</tr>
<tr>
<td>þ (sm Icelandic Thorn) *</td>
<td></td>
<td></td>
</tr>
<tr>
<td>~ (tilde character)</td>
<td>~ (sp)</td>
<td>~ (sp)</td>
</tr>
<tr>
<td>' (grave accent)</td>
<td>' (sp)</td>
<td>' (sp)</td>
</tr>
<tr>
<td>' (apostrophe)</td>
<td>' (sp)</td>
<td>' (sp)</td>
</tr>
<tr>
<td>' (acute accent) *</td>
<td></td>
<td></td>
</tr>
<tr>
<td>^ (circumflex character)</td>
<td>^ (sp)</td>
<td>^ (sp)</td>
</tr>
<tr>
<td>&quot; (double quote)</td>
<td>&quot; (sp)</td>
<td></td>
</tr>
<tr>
<td>` (dieresis) *</td>
<td></td>
<td></td>
</tr>
<tr>
<td>, (cedilla) *</td>
<td></td>
<td></td>
</tr>
<tr>
<td>À (A grave)</td>
<td>'A</td>
<td>A'</td>
</tr>
<tr>
<td>à (a grave)</td>
<td>'a</td>
<td>a'</td>
</tr>
<tr>
<td>À (A acute)</td>
<td>'A</td>
<td>A'</td>
</tr>
<tr>
<td>á (a acute)</td>
<td>'a</td>
<td>a'</td>
</tr>
<tr>
<td>Â (A circumflex)</td>
<td>^A</td>
<td>A^</td>
</tr>
<tr>
<td>â (a circumflex)</td>
<td>^a</td>
<td>a^</td>
</tr>
<tr>
<td>Ñ (A tilde)</td>
<td>~A</td>
<td>A~</td>
</tr>
<tr>
<td>ã (a tilde)</td>
<td>~a</td>
<td>a~</td>
</tr>
<tr>
<td>Character</td>
<td>Two-Key Sequence</td>
<td>Three-Key Sequence</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Å (A umlaut)</td>
<td>&quot;A</td>
<td>A&quot;</td>
</tr>
<tr>
<td>ä (a umlaut)</td>
<td>&quot;a</td>
<td>a&quot;</td>
</tr>
<tr>
<td>À (A ring)</td>
<td>'A or &quot;A</td>
<td>A' or A° (degree sign)</td>
</tr>
<tr>
<td>à (a ring)</td>
<td>'a or &quot;a</td>
<td>a' or a° (degree sign)</td>
</tr>
<tr>
<td>ÅE (AE ligature)</td>
<td>AE</td>
<td>AE (order sensitive)</td>
</tr>
<tr>
<td>æ (ae ligature)</td>
<td>ae</td>
<td>ae (order sensitive)</td>
</tr>
<tr>
<td>Ç (C cedilla)</td>
<td>,C</td>
<td>C,</td>
</tr>
<tr>
<td>ç (c cedilla)</td>
<td>,c</td>
<td>c,</td>
</tr>
<tr>
<td>È (E grave)</td>
<td>'E</td>
<td>E'</td>
</tr>
<tr>
<td>è (e grave)</td>
<td>'e</td>
<td>e'</td>
</tr>
<tr>
<td>È (E acute)</td>
<td>'E</td>
<td>E'</td>
</tr>
<tr>
<td>é (e acute)</td>
<td>'e</td>
<td>e'</td>
</tr>
<tr>
<td>Ê (E circumflex)</td>
<td>^E</td>
<td>E^</td>
</tr>
<tr>
<td>ê (e circumflex)</td>
<td>^e</td>
<td>e^</td>
</tr>
<tr>
<td>ÊE (E umlaut)</td>
<td>&quot;E</td>
<td>E&quot;</td>
</tr>
<tr>
<td>êe (e umlaut)</td>
<td>&quot;e</td>
<td>e&quot;</td>
</tr>
<tr>
<td>Ì (I grave)</td>
<td>'Ì</td>
<td>Ì'</td>
</tr>
<tr>
<td>ì (i grave)</td>
<td>'ì</td>
<td>ì'</td>
</tr>
<tr>
<td>Ì (I acute)</td>
<td>'ì</td>
<td>ì'</td>
</tr>
<tr>
<td>ì (i acute)</td>
<td>'ì</td>
<td>ì'</td>
</tr>
<tr>
<td>Ì (I circumflex)</td>
<td>^Ì</td>
<td>Ì^</td>
</tr>
<tr>
<td>ì (i circumflex)</td>
<td>^ì</td>
<td>ì^</td>
</tr>
<tr>
<td>ÌI (I umlaut)</td>
<td>&quot;Ì</td>
<td>Ì&quot;</td>
</tr>
<tr>
<td>ìI (i umlaut)</td>
<td>&quot;ì</td>
<td>ì&quot;</td>
</tr>
<tr>
<td>Ñ (N tilde)</td>
<td>~N</td>
<td>N~</td>
</tr>
<tr>
<td>ñ (n tilde)</td>
<td>~n</td>
<td>n~</td>
</tr>
</tbody>
</table>
Creating Alternate Characters

<table>
<thead>
<tr>
<th>Character</th>
<th>Two-Key Sequence</th>
<th>Three-Key Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ö (O grave)</td>
<td>Ö</td>
<td>Ö'</td>
</tr>
<tr>
<td>ô (o grave)</td>
<td>'o</td>
<td>o'</td>
</tr>
<tr>
<td>Ö (O acute)</td>
<td>'O</td>
<td>O'</td>
</tr>
<tr>
<td>ó (o acute)</td>
<td>'o</td>
<td>o'</td>
</tr>
<tr>
<td>Ô (O circumflex)</td>
<td>Ô</td>
<td>Ô'</td>
</tr>
<tr>
<td>ô (o circumflex)</td>
<td>'ô</td>
<td>o'</td>
</tr>
<tr>
<td>Õ (O tilde)</td>
<td>Õ</td>
<td>Ô~</td>
</tr>
<tr>
<td>ô (o tilde)</td>
<td>'ô</td>
<td>Ô~</td>
</tr>
<tr>
<td>Ö (O umlaut)</td>
<td>&quot;Ô</td>
<td>O&quot;</td>
</tr>
<tr>
<td>ô (o umlaut)</td>
<td>&quot;ô</td>
<td>o&quot;</td>
</tr>
<tr>
<td>ÕE (OE ligature) **</td>
<td></td>
<td>OE</td>
</tr>
<tr>
<td>œ (oe ligature) **</td>
<td></td>
<td>oe</td>
</tr>
<tr>
<td>Ü (U grave)</td>
<td>Ü</td>
<td>Ü'</td>
</tr>
<tr>
<td>û (u grave)</td>
<td>'û</td>
<td>u'</td>
</tr>
<tr>
<td>Ú (U acute)</td>
<td>'Ú</td>
<td>U'</td>
</tr>
<tr>
<td>ú (u acute)</td>
<td>'û</td>
<td>u'</td>
</tr>
<tr>
<td>Ù (U circumflex)</td>
<td>Ù</td>
<td>Ù'</td>
</tr>
<tr>
<td>û (u circumflex)</td>
<td>'û</td>
<td>u'</td>
</tr>
<tr>
<td>Ü (U umlaut)</td>
<td>&quot;Ú</td>
<td>U&quot;</td>
</tr>
<tr>
<td>ü (u umlaut)</td>
<td>&quot;û</td>
<td>u&quot;</td>
</tr>
<tr>
<td>Ý (Y acute)</td>
<td>'Ý</td>
<td>Y'</td>
</tr>
<tr>
<td>ý (y acute)</td>
<td>'ý</td>
<td>y'</td>
</tr>
<tr>
<td>Ý (Y umlaut) **</td>
<td>&quot;Ý</td>
<td>Y&quot;</td>
</tr>
<tr>
<td>ý (y umlaut) **</td>
<td>&quot;ý</td>
<td>y&quot;</td>
</tr>
</tbody>
</table>
CursorBlinkRate=speed

Sets the speed in milliseconds for the cursor blinking action. Speed can be 0 to 65535 ms.

programs=list

Specifies the files displayed in the MS-DOS Executive window when you select the Programs command from the View menu. The list contains the file extensions without the period. Separate the file extensions with spaces.

NullPort=port

Defines the name for the null port to a specified port. The Control Panel, Spooler, and other applications use this port when an output device is installed, but is not connected to any port.

load=list

Starts the specified applications as icons when you start MS-Windows. The list contains the application file names as they are displayed in the MS-DOS Executive window without the file extension. (For example, Calculator is CALC, because CALC.EXE is the application file name.) Include a space between the file names. MS-Windows first searches the current drive, the directory, then the path. Otherwise, specify a path name.

To start the MS-DOS Executive window as an icon when you first start MS-Windows, you must specify another application to start in a window. Use run= to start an application in a window and to start the MS-Executive window as an icon.

You can also start an application as an icon and open a file for that application by adding the file name and the file extension to the load setting.

To use this option, you must define the application in the Extensions section of the WIN.INI file.

For example, DOTTHIS.TXT starts Notepad because .TXT is in the Extensions section, starting the Notepad application.
run=list

Starts the specified applications in windows when you start MS-Windows. You list the file names exactly as they are displayed in the MS-DOS Executive window without the file extension.

When you specify an application to start in a window when you start MS-Windows, the MS-Executive window automatically starts as an icon. Include a space between the file names. MS-Windows first searches the current drive, the directory, then the path. Otherwise, specify a path name.

You should not specify a file name either for a special application or for an application that uses a large amount of memory; otherwise, you will enter an endless loop when you exit from the application.

You can arrange windows by using spaces to designate windows within the same column, and commas to designate a new column.

You can start an application and open a data or text file in a window when you start MS-Windows by adding the file name and the file extension in the run setting. To use this option, you must define the application in the Extensions section of the WIN.INI file.

device=name,driver,port

Defines the default printer (or plotter):

name Is the name of the default device. You must also specify this default device in the Devices section.

driver Is the file containing the device’s printer file name without the file extension.

port Is the port to which the device is connected. You must also specify this port in the Ports section.

SwapMouseButtons=setting

Swaps the functions performed by the left and right mouse buttons. Setting can be:

No The left mouse button controls the mouse functions. This is the default.

Yes The right mouse button controls the mouse functions.
Windows Section Example

The following Windows section:

- Enables the spooler when printing.
- Sets the mouse double-click speed to 900 ms.
- Sets the cursor blink rate to 550 ms.
- Specifies that files with the .COM, .EXE, and .BAT file extensions are displayed in the MS-DOS Executive window when you use the Programs command.
- Specifies None as the null port.
- Using no file specifications, starts Notepad and Calculator as icons, and starts Notepad with the text file ONGOING.TXT.
- Starts Clock in the first window of the first column, Calculator in the second window of the first column, Notepad in the first window of the second column, and Notepad with the file specification K:\MEMOS\ONGOING.TXT in the second window of the second column.
- Sets the default printer to a DIGITAL LA75, which is connected to the LPT1: port.
- Does not switch the left and right mouse buttons.

Example

```
[windows]
spooler=yes
DoubleClickSpeed=900
CursorBlinkRate=550
program=com exe bat
NullPort=none
load=notepad calc ongoing.txt
run=clock calc,notepad K:\memos\ongoing.txt
device=LA75DEC,LA75,LPT1:
SwapMouseButtons=No
```
Extensions Section

Purpose

In the Extensions section, you can specify file extensions that let you start an application and open a file in a single operation. When you select a file with the specified extension, MS-Windows starts the application and opens the file in one step.

NOTE
To change the Extensions section, use the Notepad application.

Format

[extensions]
extension=application[parameter]

Where:

extension Is the file extension that starts the application.
application Is the name of the application that is started. You must include the application's extension (.EXE).
parameter Is the name and extension of the file (optional) for the application to open. You can use a caret (^) to represent any file with that extension (for example, ^.TXT). Then you can select any file with the specified extension, and MS-Windows starts the application with that file.
Extensions Section Example

The following Extensions section:

- Starts the Notepad application when you specify a file containing a .TXT file extension. Notepad opens the file.

- Starts the Notepad application when you specify a file containing an .INI file extension. Notepad opens the file.

- Starts the MS-Paint application when you specify a file containing an .MSP file extension. Paint opens the file.

Example

[extensions]
txt=notepad.exe .txt
ini=notepad.exe .ini
msp=paint.exe .msp
Information About the WIN.INI File

Colors Section

Purpose

The Colors section specifies the shading for various components of the MS-Windows screen.

NOTE

To change the Colors section, use the Control Panel. Set your screen to have contrasting text and background colors. Otherwise, your screen could look blank.

Format

[colors]
component=redvalue greenvalue bluevalue

Where:

component

Specifies the component of the MS-Windows screen. The component can be:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window</td>
<td>Is the nontextual background of the window work area.</td>
</tr>
<tr>
<td>WindowText</td>
<td>Is the textual display in the window work area.</td>
</tr>
<tr>
<td>Scrollbar</td>
<td>Is the scroll bar.</td>
</tr>
<tr>
<td>ActiveTitle</td>
<td>Is the background of the active title bar.</td>
</tr>
<tr>
<td>InactiveTitle</td>
<td>Is the background of the inactive title bar.</td>
</tr>
<tr>
<td>TitleText</td>
<td>Is the application title's text.</td>
</tr>
<tr>
<td>WindowFrame</td>
<td>Is the set of lines that form the frame of the window and the nontextual part of the application's title background.</td>
</tr>
<tr>
<td>Menu</td>
<td>Is the nontextual background of the menu area.</td>
</tr>
<tr>
<td>MenuText</td>
<td>Is the textual display in the menu area.</td>
</tr>
<tr>
<td>Background</td>
<td>Is the icon area and screen background.</td>
</tr>
</tbody>
</table>
Information About the WIN.INI File

PIF Section Example

The following PIF section:

- Sets the swap disk to the default.
- Sets the swap size to the default.
- Creates a program information entry for COMMAND.COM with a 32K byte memory requirement.

Example

[pif]
swapdisk=*
swapsize=0
command.com=32
Ports Section

Purpose

The Ports section lists the available communication ports for a workstation and defines the default modes or settings. The Ports section can include up to eight entries.

**NOTE**
To change the Ports section, use the Control Panel.

Format

```
[ports]
port:=baudrate,parity,wordlength,stopbits,[retry]
filename.PRN=
```

Where:

**port:**

- Is the name of the available port. Port can be LPT1:, LPT2:, LPT3:, COM1:, or COM2:.
- If the port is COM1: or COM2:, you must specify in order the:
  - **baud rate**
    - Is the port's baud rate.
  - **parity**
    - Is the parity setting: o (odd), e (even), or n (none).
  - **word length**
    - Is the length of a word, in bits.
  - **stop bits**
    - Is the number of stop bits.
  - **retry**
    - Controls continuous retry on a timeout. This option is used if the port is used only for a serial printer. If you leave this option blank, the current setting does not change.

The retry options are:

- `p` which enables continuous retry on a timeout
- `n` which disables continuous retry on a timeout
DecInfo Section Example

The following DecInfo section:

- Defines the location of the on-line Information System data files as drive H in the DECAPP subdirectory.
- Defines the name of database as INFOUSER.
- Defines the location of your specific information regarding the on-line Information System as drive I.

Example

```
[DecInfo]
DBpath=H:\DECAPP
DBname=INFOUSER
BMpath=I:\
```
Information About the WIN.INI File

Devices Section

Purpose

The Devices section identifies a workstation's output devices, the printer files, and the port connections.

NOTE
To change the Devices section, use the Control Panel.

Format

[devices]
device=driver, port[, port]

Where:

device Is the name of the output device where:

driver Is the file name of the device's printer driver.

port Is the name of the communication port or print file to which the device is connected (optional). Port can be LPT1, LPT2, LPT3, COM1, or COM2. If a device is not currently connected, the port should be the port specified in the NullPort setting of the Windows section.

Devices Section Example

- Defines the DIGITAL LN03 printer as connected to the null port and to the LPT3: communication port.
- Defines the LA75DEC printer as connected to the LPT1: communication port.
- Defines the IBM Graphics printer as the null port.

Example

[devices]
Digital LN03=LN03, None, LPT3:
LA75DEC=LA50, LPT1:
IBM Graphics=IBMGRX, None
Fonts Section

Purpose
The Fonts section identifies one or more font types that MS-Windows applications can use for display.

NOTE
To change the Fonts section, use the Control Panel.

Format

[fonts]
fontname=fontfile

Where:

fontname Is the descriptive name of a font. The fontfile is the name of the file containing the font resources. Do not use the file extension.

Fonts Section Example
The following Fonts section:

- Defines the Courier font.
- Defines the Helvetica font.

Example

[fonts]
Courier 8,10,12 (Set #3)=COURC
Helv 8,10,12(Set#3)=HELVC
Appendix C
Program Information Files

This appendix describes how to:

• Use Program Information Files (PIFs)
• Use the PIF editor
• Select PIF options
• Use default settings
• Decide what to put in a PIF
• Change PIFs
• Give applications more memory

Using Program Information Files

A program information file (PIF) is a file that contains information about a standard application. It has the file extension .PIF. When you run a standard application, MS-Windows looks for a PIF to configure the application.

PIFs for most popular standard applications are included with your MS-Windows software package. During setup, the Installation Aide installs PIFs in the PIF subdirectory to establish a PIF library. You probably will not enter information into a PIF unless you use a standard application that does not have a PIF.
**Program Information Files**

**NOTE**
If you try to run a standard application that does not have a PIF, MS-Windows automatically uses a set of default application characteristics. MS-Windows displays a dialog box asking if it should "Continue with default settings." You should create a PIF, using the correct values from your application documentation.

If you run an application by selecting the file name of the application (files that have the file extension .EXE, .COM, or .BAT), the PIF must have the same file name and the file extension .PIF. For example, if you use dBASE II, its application file name is DBASE.EXE, and its PIF must be DBASE.PIF.

You can also run an application by selecting its PIF in the MS-DOS Executive window. This automatically loads and runs the application named in the PIF. In this case, the PIF does not have to have the same file name as the application.

The preferred method is to run a standard application by selecting its PIF. This allows you to have customized PIFs, which are several PIFs containing different settings for the same application. Therefore, you can customize an application to the needs of different users, each with their own specific MS-Windows environment.

For example, one version, APPLARGE.PIF, may need a large amount of memory for those that use all of its features, and a second version, APPSMALL.PIF, may need less memory for those who use only a few of its features.

Additionally, each user can have customized values for the Program Parameters or Initial Directory fields in their PIFs. Customized PIFs must be in the user's personal directory.

The PIF must be in your directory or in your path. It should be copied from the PIF subdirectory to the directory from which you run the application.
In some cases, different applications use the same file name to start up. Therefore, some PIFs can have names that differ from their applications. If you are not sure which application a PIF works with, run the PIF editor and open the PIF to see which application the PIF was designed for, then copy the PIF to the appropriate drive and directory, and rename the file.

Some applications can have more than one .EXE, .COM, or .BAT file on their disk. You need a separate PIF for each file.

**Using the PIF Editor**

To create or edit a PIF, use the PIF editor. For example, you can change the application settings to increase the amount of memory available to the application or to set its initial directory.

To get on-line help about using the PIF editor:

1. Select the About command from the System menu.
   
   A dialog box is displayed that lists topics about PIFs.
2. Select a topic from the list box.
3. Select the Help command button.
   
   Information about the selected topic is displayed in the dialog box. You may need to scroll to see all the information.

   By using the command buttons in the dialog box, you can obtain information about other PIF topics.

When you finish using the PIF help feature, select the Cancel command button.
Creating a PIF

To create a new PIF:

1. Use the Run command in the MS-DOS Executive window to start the PIF editor application. The file name of the PIF editor is PIFEDIT.EXE.

   The Program Information Editor window is displayed. Screen C-1 shows the Program Information Editor window.

2. Type the file name of the application to be associated with the PIF in the Program Name text box. Include the file extension (.EXE, .COM, or .BAT).

3. Select the options or values that apply to the application. (For more information, see the section “Selecting PIF Options” in this appendix.)

4. Select the Save command from the File Menu to save the new PIF.

Screen C-1  Program Information Editor Window
To create another PIF, select the New command from the File Menu to reset the PIF editor screen.

**Editing PIFs**

To edit an existing PIF:

1. Use the Run command in the MS-DOS Executive window to start the PIF editor. The file name of the PIF editor is PIFEDIT.EXE.
2. Select the Open command from the File Menu.
3. Select the PIF you want to change from the list box or type the name of the PIF in the text box.
4. Select the Open button.
5. Make the desired changes by selecting the PIF options you want.
6. Select the Save command from the File Menu to save the changes.

**Selecting PIF Options**

PIF options are organized into these categories:

- Program Name
- Program Title
- Program Parameters
- Initial Directory
- Memory Requirements
- Directly Modifies
- Program Switch
- Screen Exchange
- Close Window on exit
Program Information Files

Program Name

Every application (program) must have a file name assigned.

Type the path and file name of the application, including the file extension .EXE, .BAT, or .COM. For example, DBASE.COM is a file for the application DBASE. What you enter is displayed in the MS-DOS Executive window directory.

Program Title

You can enter a descriptive title for the application to help the user identify it on the screen.

What you enter is displayed in the title bar of the window, if the application runs in a window. This same title is also displayed above the icon of the application when you highlight the icon in the icon area.

NOTE
The PIF editor lets you enter 37 characters in the text box; however, only 29 characters are displayed in the title box.

Program Parameters

The Program Parameters option lets you pass information to an application when you start it. In the Program Parameters text box, you can type either of the following:

• Question mark

If you type a question mark, MS-Windows displays a dialog box when you start the application. The dialog box prompts you for application parameters. You can enter up to 126 characters in the dialog box; however, the application interprets no more than 126 characters. If you enter more than 126 characters, MS-Windows does not beep to indicate an error.

• Specific program parameters

If you type specific parameters, those application parameter values are used every time the application is started. You can enter up to 37 characters in the Program Parameters text box.

You should not redirect input and output or use piping.

If your application requires no parameters, or if you are uncertain, leave this option blank.

C-6
Program Information Files

Initial Directory

If you have several directories, this option changes to a specific directory when the application starts.

Type the drive and directory you want MS-Windows to change to when you start the application. This directory is usually the location of the application's data files.

You can use the Initial Directory field and the Program Name field to make a customized PIF for applications shared on a file server. In the Program Name field, enter the drive and directory of the application. In the Initial Directory field, enter the drive and name of your personal directory. (Complete the other PIF fields as needed.) Make sure this customized PIF is in your personal directory.

When you select the customized PIF to run an application, MS-Windows copies the application from its drive and directory and starts it in your personal directory where the data files are. The application can then use the data files. When you close the application, the updated data files remain in your personal directory.

If the data files are in the same directory as the application, leave this option blank. In this case, MS-Windows does not change the directory when you start the application.
Program Information Files

Memory Requirements

Two fields for Memory Requirements allocate memory for your applications:

- **KB Required**
  
  Type the minimum amount of memory required (in kilobytes) by your application.

  Memory requirements for your application should be in the application documentation.

  If you do not know how much memory is required, use the default setting of 52K bytes.

  If MS-Windows cannot provide the specified amount of memory, and if no application is running other than the MS-DOS Executive application, MS-Windows reduces its space requirements so that the application has room to operate. In this case, you cannot switch back to MS-Windows with the Alt/Tab keys; you must execute the application’s Exit command, or its equivalent, to return to MS-Windows.

- **KB Desired**

  Type the maximum amount of memory your application can use. Some applications run better if you assign more memory.

  The value entered in this field should at least equal the value entered in the KB Required field. If the application allocates memory, you should increase the value in the KB Desired field, and you may also need to increase the value in the KB Required field.

  If you enter zero (0), MS-Windows allocates all available MS-Windows memory to the application.

  If you leave this field blank, MS-Windows uses the default setting of 52K bytes.

  **CAUTION**

  You should not run the CHKDSK (Check Disk) utility program from MS-Windows; otherwise, it can provide invalid messages about memory availability. If you select the /F qualifier of CHKDSK, you can destroy all data stored on your workstation network disk.
Directly Modifies

Some applications use workstation resources such that applications cannot share them. Select any options that apply to your application:

- **Screen**
  
  Select this box if the application writes directly to the screen (video buffer) or if the application has a .BAT extension and uses redirected I/O. All standard applications that display graphics write directly to the screen.

  Selecting this option gives the application exclusive access to the full screen, rather than running it in a window. If you are uncertain, select this option.

- **Keyboard**
  
  Select this box if the application accesses the keyboard buffer. This buffer saves keystrokes until they can be processed.

  Selecting this option prevents the application from running in a window (the application has exclusive access to the full screen) and prevents returning to MS-Windows with Alt/Tab. If you are uncertain, do not select this option.

- **COM1**
  
  Select this box if your application accesses serial communications port 1 (COM1). If you select this option, MS-Windows reserves COM1 for the application. When the application is running, MS-Windows cannot run any other application using COM1 until you stop running the first application. Generally, you select this option only if you are running a communications application.

  Selecting this option prevents two applications from trying to access the same communications port at the same time. Because only one application with the COM1 option selected can be running at a time, only one application attempts to access COM1.

  Selecting this option also prevents the application from being swapped to a disk. This type of application must remain in memory at all times.
**Program Information Files**

- **COM2**
  
  Select this box if your application accesses serial communications port 2 (COM2). If you select this option, MS-Windows reserves COM2 for the application. When the application is running, MS-Windows cannot run any other application using COM2 until you stop running the first application. Generally, you select this option only if you are running a communications application.

  Selecting this option prevents two applications from trying to access the same communications port at the same time. Since only one application with the COM2 option selected can be running at a time, only one application attempts to access COM2.

  Selecting this option also prevents the application from being swapped to a disk. This type of application can remain in memory at all times.

- **Memory**
  
  Select this box only if your application loads and remains resident (using a Terminate and Stay Resident system call). Many pop-up applications do this. These applications generally load and remain in memory, and are activated while other applications are running. Generally, this type of application must be loaded before MS-Windows. In this case, you do not need a PIF for the application. If you are uncertain, do not select this option.
Program Switch

If your application uses the entire screen, these options determine whether you can switch back to MS-Windows with Alt/Tab. If you are uncertain which option to select, select Text.

- Prevent
  
  Select this option to conserve memory for the application, or if you find that the application does not switch to MS-Windows correctly. Selecting this option means you can stop running the application only by executing its Exit command, or the equivalent command, to return to MS-Windows. You cannot use the Alt/Tab procedure to return to MS-Windows.

- Text
  
  Select this option if your application works in text mode only, or if it runs in text and graphics modes, and you want to conserve memory. When you select this option, MS-Windows reserves 4K bytes to save the screen.

  If you select this option, you can switch back to MS-Windows only when your application is in text mode. If the application is in graphics mode, MS-Windows beeps when you press the Alt/Tab keys, to let you know it is not a valid action; you must execute the Exit command of the application to return to MS-Windows.

- Graphics/Multiple Text
  
  Select this option if your application works in graphics mode. If you select this option, MS-Windows allocates extra memory (64K bytes) for you to switch back to MS-Windows when the application is in text or graphics mode.

  Due to extensive memory requirements, program switching is not supported for applications using IBM EGA high-resolution color modes.
Program Information Files

Screen Exchange

These options let you specify the kind of data exchange between applications that require exclusive access to the screen.

You press Alt/Prt Sc to copy information into the Clipboard. This requires MS-Windows to allocate memory to save the screen image in the Clipboard. Text screens generally do not require much memory (2K bytes). However, graphics screens can require up to 64K bytes of memory. You should select options with this in mind.

If you are uncertain which option to select, select Text.

- None
  Select this option to prevent screen exchange and conserve memory.

- Text
  Select this option to allocate memory to copy text screens. If your application runs in a window, you can select this option.

- Graphics/Text
  Select this option to allocate memory to copy text and graphics screens.

Close Window On Exit

Select this option to close the standard application window when you execute the application’s Exit command, or its equivalent.

When you exit from some standard applications, they display information in the window for you to look at or copy. Do not select this option, because the window closes automatically, and the information is not displayed on the screen long enough for you to read it.
Using Default Settings

If you run an application, and MS-Windows cannot find a PIF, MS-Windows uses the following settings:

- Program Title: The application file name is displayed in the title bar.
- Initial Directory: You stay in your current directory.
- Memory Required: 52K bytes
- Memory Desired: All available memory
- Directly Modifies: Screen
- Program Switch: Prevent
- Screen Exchange: Text

Deciding What to Put in a PIF

How an application is displayed on the screen depends on:

- How the application uses workstation resources and hardware
- How the application is configured
- The amount of memory reserved for the application

If MS-Windows cannot run a standard application in a window, it runs the application outside a window, and the application uses the entire screen.

Use the following guidelines to help determine whether your standard application can run in a window:

- Does the application write directly to the screen (video buffer)?
  Many standard applications write directly to the screen instead of using DOS or other system conventions to display information (such as ANSI calls). These applications cannot run in a window. You must select the Directly Modifies screen option if your application writes to the screen.
- Does the application display graphics?
  Standard applications that display bit-mapped graphics (not character-based) write directly to the screen and cannot run in a window.
Program Information Files

- Does the application provide an installation option for running under different screen conventions?
  Standard applications that support ANSI screen drivers can run in a window.

- How much memory does the application require?
  If the memory requirements of the standard application and MS-Windows together exceed the amount of available memory, the application cannot run in a window. MS-Windows "steps aside" and gives the application the maximum amount of memory available.

- Does the application use the alarm?
  Applications that use the alarm function of the real-time clock must run outside MS-Windows. At the minimum, you should select the Directly Modifies keyboard option.

  For standard applications that run in a window, MS-Windows does not support the following ANSI escape sequences:
  - Cursor Position Report
  - Set Mode
  - Keyboard Reassignment
  - Set Graphics Renditions subsets:
    - Faint on
    - Italic on
    - Rapid blink on
    - Subscript
    - Superscript

  Select the Directly Modifies screen option in the PIF for any application that uses these.

  To experiment, run the application without setting the Directly Modifies screen option. If the application writes information outside its window, or you see unexpected results on the screen, edit the PIF and select the Directly Modifies screen option.
Changing PIFs

Generally, you do not have to change the information in the PIFs. However, to change any parameters for a particular application by editing a PIF, you can tailor the performance characteristics of its application.

For example, to give Lotus 1-2-3 the maximum amount of available memory in your workstation, change the amount in the KB Required and KB Desired options to 640K bytes and select None for the Screen Exchange option and Prevent for the Program Switch option. Close all other applications except for the MS-DOS Executive, then run the application.

Some applications provide an option to install and run the application with an ANSI device driver (ANSI.SYS). If the application offers this option, you can usually run it in a window.

Since the application can now run in a window, you must alter the PIF. You should cancel the Directly Modifies Screen option. (Do this for all related .COM or .EXE files included in the application.)

If you run an application, and it does not load properly or is not operating as expected, check your PIF settings. You may need to increase the memory requirements of the application.

Giving Applications More Memory

When you run a standard application, MS-Windows allocates memory based on the settings in the PIF of the application. MS-Windows allocates memory for screen exchange (copying the screen) and for program switching (switching between the application and MS-Windows).

You can reduce the memory requirements for an application by selecting options that require less memory:

- The Screen Exchange Text option
- The Screen Exchange None and the Program Switch Prevent options